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General Information 
DBDesigner 4 is a free available database design system that integrates database 
design, modelling, creation and maintenance into a single, seamless environment. 

It is written for Microsoft© Windows 2k/XP© and Linux KDE/Gnome to support both, 
the Windows and the Linux platform. 

DBDesigner 4 is developed and optimized for the MySQL-Database. 

License 

DBDesigner is available for free download and is published under the GNU GPL License. 

Click here to read through the GNU GPL License. 

Support 

Free support is available during beta test phase. Please navigate to fabforce.net. 

Bug submission 

If you have found a bug or got an idea for new functions and features please visit 
fabforce.net. 

Copyright 2003 fabFORCE.net. All rights reserved. 
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License 

GNU GENERAL PUBLIC LICENSE 

Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc.
59 Temple Place, Suite 330, Boston, MA 02111-1307 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

Preamble

The licenses for most software are designed to take away your freedom to share and 
change it. By contrast, the GNU General Public License is intended to guarantee your 
freedom to share and change free software--to make sure the software is free for all its 
users. This General Public License applies to most of the Free Software Foundation's 
software and to any other program whose authors commit to using it. (Some other Free 
Software Foundation software is covered by the GNU Library General Public License 
instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General 
Public Licenses are designed to make sure that you have the freedom to distribute 
copies of free software (and charge for this service if you wish), that you receive source 
code or can get it if you want it, that you can change the software or use pieces of it in 
new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you 
these rights or to ask you to surrender the rights. These restrictions translate to certain 
responsibilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you 
must give the recipients all the rights that you have. You must make sure that they, 
too, receive or can get the source code. And you must show them these terms so they 
know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this 
license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone 
understands that there is no warranty for this free software. If the software is modified 
by someone else and passed on, we want its recipients to know that what they have is 
not the original, so that any problems introduced by others will not reflect on the 
original authors' reputations.



Finally, any free program is threatened constantly by software patents. We wish to 
avoid the danger that redistributors of a free program will individually obtain patent 
licenses, in effect making the program proprietary. To prevent this, we have made it 
clear that any patent must be licensed for everyone's free use or not licensed at all. 
The precise terms and conditions for copying, distribution and modification follow.

GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

0. This License applies to any program or other work which contains a notice placed by 
the copyright holder saying it may be distributed under the terms of this General Public 
License. The "Program", below, refers to any such program or work, and a "work based 
on the Program" means either the Program or any derivative work under copyright law: 
that is to say, a work containing the Program or a portion of it, either verbatim or with 
modifications and/or translated into another language. (Hereinafter, translation is 
included without limitation in the term "modification".) Each licensee is addressed as 
"you".

Activities other than copying, distribution and modification are not covered by this 
License; they are outside its scope. The act of running the Program is not restricted, 
and the output from the Program is covered only if its contents constitute a work based 
on the Program (independent of having been made by running the Program). Whether 
that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program's source code as you 
receive it, in any medium, provided that you conspicuously and appropriately publish on 
each copy an appropriate copyright notice and disclaimer of warranty; keep intact all 
the notices that refer to this License and to the absence of any warranty; and give any 
other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your 
option offer warranty protection in exchange for a fee. 
2. You may modify your copy or copies of the Program or any portion of it, thus forming 
a work based on the Program, and copy and distribute such modifications or work 
under the terms of Section 1 above, provided that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices stating that you 
changed the files and the date of any change. 
b) You must cause any work that you distribute or publish, that in whole or in part 
contains or is derived from the Program or any part thereof, to be licensed as a whole 
at no charge to all third parties under the terms of this License.

c) If the modified program normally reads commands interactively when run, you must 
cause it, when started running for such interactive use in the most ordinary way, to 
print or display an announcement including an appropriate copyright notice and a notice 
that there is no warranty (or else, saying that you provide a warranty) and that users 
may redistribute the program under these conditions, and telling the user how to view a 
copy of this License. (Exception: if the Program itself is interactive but does not 
normally print such an announcement, your work based on the Program is not required 
to print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of 
that work are not derived from the Program, and can be reasonably considered 
independent and separate works in themselves, then this License, and its terms, do not 



apply to those sections when you distribute them as separate works. But when you 
distribute the same sections as part of a whole which is a work based on the Program, 
the distribution of the whole must be on the terms of this License, whose permissions 
for other licensees extend to the entire whole, and thus to each and every part 
regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work 
written entirely by you; rather, the intent is to exercise the right to control the 
distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the 
Program (or with a work based on the Program) on a volume of a storage or 
distribution medium does not bring the other work unde the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in 
object code or executable form under the terms of Sections 1 and 2 above provided 
that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which 
must be distributed under the terms of Sections 1 and 2 above on a medium 
customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third 
party, for a charge no more than your cost of physically performing source distribution, 
a complete machine-readable copy of the corresponding source code, to be distributed 
under the terms of Sections 1 and 2 above on a medium customarily used for software 
interchange; or,

c) Accompany it with the information you received as to the offer to distribute 
corresponding source code. (This alternative is allowed only for noncommercial 
distribution and only if you received the program in object code or executable form with 
such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making 
modifications to it. For an executable work, complete source code means all the source 
code for all modules it contains, plus any associated interface definition files, plus the 
scripts used to control compilation and installation of the executable. However, as a 
special exception, the source code distributed need not include anything that is 
normally distributed (in either source or binary form) with the major components 
(compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a 
designated place, then offering equivalent access to copy the source code from the 
same place counts as distribution of the source code, even though third parties are not 
compelled to copy the source along with the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly 
provided under this License. Any attempt otherwise to copy, modify, sublicense or 
distribute the Program is void, and will automatically terminate your rights under this 
License. However, parties who have received copies, or rights, from you under this 
License will not have their licenses terminated so long as such parties remain in full 
compliance.

5. You are not required to accept this License, since you have not signed it. However, 
nothing else grants you permission to modify or distribute the Program or its derivative 



works. These actions are prohibited by law if you do not accept this License. Therefore, 
by modifying or distributing the Program (or any work based on the Program), you 
indicate your acceptance of this License to do so, and all its terms and conditions for 
copying, distributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the 
recipient automatically receives a license from the original licensor to copy, distribute or 
modify the Program subject to these terms and conditions. You may not impose any 
further restrictions on the recipients' exercise of the rights granted herein. You are not 
responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for 
any other reason (not limited to patent issues), conditions are imposed on you 
(whether by court order, agreement or otherwise) that contradict the conditions of this 
License, they do not excuse you from the conditions of this License. If you cannot 
distribute so as to satisfy simultaneously your obligations under this License and any 
other pertinent obligations, then as a consequence you may not distribute the Program 
at all. For example, if a patent license would not permit royalty-free redistribution of 
the Program by all those who receive copies directly or indirectly through you, then the 
only way you could satisfy both it and this License would be to refrain entirely from 
distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply and the section as a whole 
is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other 
property right claims or to contest validity of any such claims; this section has the sole 
purpose of protecting the integrity of the free software distribution system, which is 
implemented by public license practices. Many people have made generous 
contributions to the wide range of software distributed through that system in reliance 
on consistent application of that system; it is up to the author/donor to decide if he or 
she is willing to distribute software through any other system and a licensee cannot 
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence 
of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either 
by patents or by copyrighted interfaces, the original copyright holder who places the 
Program under this License may add an explicit geographical distribution limitation 
excluding those countries, so that distribution is permitted only in or among countries 
not thus excluded. In such case, this License incorporates the limitation as if written in 
the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the 
General Public License from time to time. Such new versions will be similar in spirit to 
the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a 
version number of this License which applies to it and "any later version", you have the 
option of following the terms and conditions either of that version or of any later 
version published by the Free Software Foundation. If the Program does not specify a 
version number of this License, you may choose any version ever published by the Free 
Software Foundation.



10. If you wish to incorporate parts of the Program into other free programs whose 
distribution conditions are different, write to the author to ask for permission. For 
software which is copyrighted by the Free Software Foundation, write to the Free 
Software Foundation; we sometimes make exceptions for this. Our decision will be 
guided by the two goals of preserving the free status of all derivatives of our free 
software and of promoting the sharing and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY 
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES 
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE 
ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH 
YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR 
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM 
(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED 
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF 
THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR 
OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Addition:

Copyright (C) 2002, Michael G. Zinner

This program is free software; you can redistribute it and/or modify
it under the terms of the GNU General Public License as published by
the Free Software Foundation; either version 2 of the License, or
(at your option) any later version.

This program is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License
along with this program; if not, write to the Free Software
Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

In addition, as a special exception, Michael G. Zinner
gives permission to link the code of this program with
the midas.dll, qtintf70.dll and dbexpmysql.dll library 
(or with modified versions of these libraries that use the same license



as these libraries), and distribute linked combinations including
the two. You must obey the GNU General Public License in all
respects for all of the code used other than midas.dll, qtintf70.dll and 
dbexpmysql.dll. If you modify this file, you may extend this exception 
to your version of the file, but you are not obligated to do so. 
If you do not wish to do so, delete this exception statement 
from your version.
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Fundamentals 
The key to successfully using DBDesigner 4 is understanding database fundamentals. 

Read through the topics summarized below - these are the features, techniques, and 
workflows that are fundamental for working with DBDesigner 4. 

Models and Databases 

In DBDesigner 4, you always work within a model. A model is a visualization of the meta-
information stored in a database (e.g. Tables and Indices, Relations, ...). Although it is 
possible to store initial data for each table directly in the model, it only represents the 
meta-information, not the data itself. 

You can create and maintain as many models as needed, containing a unlimited number 
of objects. An object can be a database table with columns and indices, a relation 
between two tables, a note, ...

Models can be designed by placing these objects onto the model's canvas or can be 
retrieved from existing databases using the reverse engineering function. 

To create the according database the model can be exported as an SQL Creates Script 
or be created directly from within DBDesigner 4 using the synchronize function. The 
synchronize function is also used to alter the database automatically when the model 
has changed. 

When DBDesigner 4 is switched to Query Mode the model can be used to build complex 
SQL querys and edit the tables' data. 

The models are saved to XML-files or can be directly stored within the database enabling 
distributed access to the model. 

The User Interface 

The user interface has been based on industry standard layouting software. This makes 
creating your database models very easy. 



DBDesigner GUI 

Beside the familiar window-menus, scrollbars and status-bar DBDesigner 4 provides 
several palettes (floating windows) which can be used to access frequently used 
functions more quickly. 

DBDesigner 4 makes extensive use of standard windows functions like popup-menus 
which are accessed by a right mouse click. They provide context sensitive functions for 
the objects. Drag-n-Drop is used to assigning datatypes to table columns or building 
table indices.



The Table Popup Menu 

DBDesigner 4 supports the Multible Document Interface (MDI) which allows you to open 
an unlimited number of models at the same time. You can switch between the models 
and use standard copy and paste commands to exchange objects between the models. 

Modelling 

The database model is created by placing several objects on the canvas, specify their 
attributes and relations. 

To place an object you have to select the appropriate tool from the Tools-Bar. Beside 
the most important objects like Tables and Relations (1:1, 1:1 generalization, 1:n, 1:n 
non identifying, n:m) you can use Notes, Images and Regions which help to 
"understand" the model's structure.



The Objects 

Tables 

Tables represent database-tables. The table is displayed in a window-like manner. The 
Table's name is displayed in the titlebar, the table columns are printed below and are 
indicated by an icon. A key icon means this column is in the table's primary key. 

Primary Key 

Usually one or more columns are defined as the table's Primary Key (PK). These 
columns must not contain two or more data values which are equal. That makes it 
possible to clearly identify each record in the table by the Primary Key (e.q. 
productnumber). 

Indices 

To make the database find a specific record in the database more quickly, it is possible 
to define an index on one or more columns. Indices are also used to improve speed 
when two or more tables are joined together.

Relations 

Relations can only be placed between two tables. They define the relationship between 
the tables and can create a Foreign Key reference. Tables can be connected by a one-to-
one (e.g. person - address), one-to-many (productgroup - product) or many-to-many 
(e.g. employee - meeting) relation. 



Notes 

Notes are simple text boxes containing information about a table or structure. They can 
be placed anywhere on the model providing information where needed.

Images 

Images can be placed on the model to visualize additional information.

Regions 

Regions provide space for tables with the same attributes. The attributes are set for the 
region and apply to all tables placed on the region automatically. Furthermore they can 
be used by plugins to apply specific functions to a group of tables.
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Modelling 
Before starting to model the database the Design Mode has to be selected. To change 
the current Work Mode click the Work Mode icon in the Tools Palette. 

Tables and Relations 

Tables and relations are the core components of each database model. Tables consist of 
the tablename, the columns and indices and various table options. Relations connect 
different tables with each other to form one-to-one or one-to-many relations. 

Place a new table 

To place a new table onto the model select the Table Tool from the Toolbar or press [T] 
on the keyboard.
The mouse cursow will change to refect the currently selected tool. 

Selecting the Table Tool 

To place the table click left on the model. A new table will be created. It will be named 
[table_XX]. The table's left upper corner will be at the position the mouse was clicked. 

After the table was placed the selected tool will change back to the Pointer Tool. The 
mouse cursor will be changed also. 

Edit a table 



To edit an existing table make shure the Pointer Tool is selected. Double click on the 
table with the left mouse button. The Table Editor will be showen.

Calling the table editor 

Defining the table's name and columns 

Enter the table's name (e.g. product) and press the return key. The focus will change to 
the first column. It will be named id+tablename by default. To accept this name press 
return or overwrite the column's name first. 

Now the focus has changed to the second column. Again enter the columns name and 
repeat for all the table's columns. 

Press the Esc key after the last column was named. 

Columns can be reorderd by draq'n'drop. Left click on a column's name, hold the mouse 
button and drag onto another column. Release the mouse button and the column will be 
inserted before the column it was dragged on. 

Assigning the columns' datatypes 

Press the Esc key after the last column was named. 

Assigning datatypes 

All columns will be created with the default datatype (use Options > Model Options to 
change the default datatype). 



Assigning datatypes 

To change the datatype of a column goto the Datatypes Palette and drag the 
appropriate datatype onto the column in the Table Editor. If the assigned datatype has 
parametes (e.g. VARCHAR(xxx)) enter the wanted value. Press Return to apply the 
changes or Esc to discard. Repeat this for all table columns. 

To change a datatypes parameters doubleclick on the datatype and enter the new 
value. 

Setting datatype parameters 

Primary key, AutoInc and Flags 

The first column has automatically been defined as primary key of the table indicated 
by a Key Icon left to the columns name. To remove a column from the primary key click 
the Key Icon. To add a column to the primary key click onto the Column Icon. 



Setting the AutoIncrement property 

To make a column automatically incrementing after each insert click the columns row in 
the AI column. 

Each datatype has specific flags. They can be activated and deactivated by clicking. 

Default Values and Comments 

To set the default value of a column doubleclick in the Default Value column and enter 
the value. Press Return to apply the changes. 

Setting Default Values 

To display the columns' Comments click the icon right to the Default Value column's 
caption. To edit a comment doubleclick in the Comments column. 

Edit the columns' comments 



Create Table Indices 

Change to the Indices Tab and click the Plus Icon to add a new index. A String Input 
dialog will appear. Enter the index's name and press return. The new index is displayed. 
Now choose the type of the index. 

Create a new table index 

To add a column to the index start dragging the column down to the Columns Listbox 
and drop it. You can reorder the columns by dragging a column onto another. To delete 
a column press the Delete button. 

Adding columns to the index 

Make a relation 



Add another table to the model using the Table Tool (e.g. productgroup) and define the 
table's columns. Now select the 1:n Relation Tool (Non-Identifying Relation) from the 
Toolbar. 

Selecting the 1:n Relation Tool (Non-Identifying Relation) 

Click on the first table (productgroup) then on the second table (product) to establish 
the relation. Note that the second table (product) now has a foreign key column 
identified by (FK) right to the datatype. 

Tables connected by a relation. 

Doubleclick on the relation to enter the relation's name. Close the Relation Editor to 
apply the changes to the model. 



Tables connected by a relation. 
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Querying 
Before starting to query the database the Query Mode has to be selected. To change 
the current Work Mode click the Work Mode icon in the Toolbar or the Tools Palette or 
select Query Mode from the Display Main Menu. 

Building selects 

SQL selects can be easily build by drag'n'drop commands. Make shure the current 
worktool is set to a Pointer Tool before starting. 

Building a simple SQL SELECT 

To build a SQL select from one table simply click on a table with the left mousebutton 
and keep holding the button. Now move the mouse cursor down. The Drag Menu is 
displayed. 

The Drag Menu 

Keep holding the left mouse button and move the mouse cursor to the SELECT button. 
Release the mouse button. The SELECT statement will be build and displayed in the 
SQL Command Editor. 

If the table which has to be queried is not visible in the current visible area of the 



model, click somewhere on the model to set the focus to the model. Now press the 
[Space] key and drag the model till the table becomes visible. 

Joining tables 

To join another table with this table click on the table to join. Start draging like before 
and release the mouse button over the JOIN Tables(s) Button. The two tables will be 
joined based on the relations between the tables. 

Two tables joined 

Another possibility is to select all tables that have to be joined by holding the Ctrl Key 
and clicking on the tables. Then start dragging and release the mouse button over the 
JOIN Tables(s) button. All tables will be joined based on the relations between them. 

Add tables without joining 

To add one or more tables to a query without performing a join drag the table(s) on the 
Add Table(s) button. They will be added to the SQL command. 

Selecting table columns 

When a SQL command is built using the Drag Menu all columns of the table(s) are 
selected using the SELECT * clause. 

To select specific table columns choose the SELECT Clause Tool from the Toolbar or 
press Ctrl + S. The mouse cursor will change to the SELECT Clause cursor. Now move 
the mouse over the table and watch the columns be highlighted. Move the mouse 
cursor to the column you want to select and press the left mouse button. 



Selecting a table's column 

To column will be added to the SELECT Statement. 

Add columns to other clauses 

Use the different Clause Tools from the Toolbar to add table columns to the SQL 
command. 

Tool Key Position

SELECT Clause Tool Ctrl + S SELECT [column] FROM ...

FROM Clause Tool Ctrl + F SELECT * FROM table_a LEFT OUTER JOIN table_b ON [column] ...

WHERE Clause Tool Ctrl + W SELECT * FROM table_a WHERE [column] ...

GROUP Clause Tool Ctrl + G SELECT * FROM table_a GROUP BY [column] ...

HAVING Clause Tool Ctrl + H SELECT * FROM table_a GROUP BY col1 HAVING [column] ...

ORDER Clause Tool Ctrl + O SELECT * FROM table_a ORDER BY [column] ...

SET Clause Tool Ctrl + E UPDATE table_a SET [column] ...

Pointer Tool Ctrl + Q -
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The User Interface 

Main Elements 

The Main Menu 

Through the main menu you gain access to general functions of the program. There are 
seven main menu items, File, Edit, Display, Database, Options, Windows and Help. 

File Menu 

The File Menu 



File - New 

File - New creates a new empty model. If you have opened another model before you 
can switch between the new and the other model using the Windows menu. 

File - Open ... 

File-Open ... opens an existing model from your harddisk or mapped network device. 
DBDesigner creates a new empty model every time it is started so you can start 
modelling immediately. If you open a model and no changes have been applied to the 
empty model it is closed automatically and replaced with the opened model. 

File - Open from Database ... 

File - Open from Database ... makes it possible to open a model saved in a database. 
When selected this menu item the DB-Connection Dialog pops up and you have to 
select the database containing the desired model. There can be stored more than one 
model in the database so you have to select the appropriate model then. 

File - Open recent 

File - Open recent displays a list of the last opened models to improve speed opening 
the most used models. If a new model is opened it is added to the list. If there are 
more than 10 entries in the list the last entry is deleted automatically. 

File - Add Model ... 

File - Add Model ... lets you add an existing model to the currently opened model. After 
the model has been imported all new objects are selected so the can be moved to an 
appropriate position. 

File - Save 

Use File-File-Save ... to save your model to the harddisk or a mapped network device. 
When you save a model for the first time, you are promt to locate the destination folder 
and enter the name of the model. The model is added to the File-Open Recent list 
automatically. 

File - Save As ... 

File - Save As ... can be used to save your current model with a new name. You are 
promt to locate the destination folder and enter the new name of the model. 

File - Save in Database ... 

It is possible to store the model directly in the database you work on. A new database 
table is used to store all models in this database. This new table does not interfere with 
the database synconisation and reverse engineering functions. 

When selected the File-Save in Database ... menu item the DB-Connection Dialog pops 
up and you have to select the database which will containing the model. You have to 
enter the desired name of the model and the model will be stored. 



File - Close 

File - Close closes the current active model. 

File - Export-SQL Create Script ... 

Use this menu item to export the current active model as a SQL Create script which can 
be executed against the datbase manually to create the nessesary tables. You can use 
the database synchronise function instead which will create and update your database 
automatically. 

File - Export-SQL Drop Script ... 

Use this menu item to export the current active model as a SQL Drop script which can 
be executed against the datbase manually to drop the desired tables. You can use the 
database synchronise function instead which will create and update your database 
automatically. 

File - Export-Export Model as Image ... 

Select this function to export the whole model as an image file. The image can be saved 
in the PNG or BMP file format. The PNG Format is recommended. Please note that using 
the BMP file format will result in very large images, approximatly 20 MB at default size. 

File - Page & Printer Setup ... 

Before printing the model you have to select the appropriate printer and set the page 
size and orientation as well as the scale factor of the model which enables you to print 
the model distributed on several pages. 

File - Print ... 

File - Print ... lets you select the pages of the model an the number of copies you want 
to print. 

File - Exit 

File - Exit closes the program. 

Edit Menu 



The Edit Menu 

Edit - Undo 

Use Edit - Undo to take back the last change applied to the model. You can use this 
command several times to take back all changes you made. 

Edit - Redo 

Edit - Redo applies the last undone action again. This command can also be repeated 
several times when you have undone several actions. 

Edit - Copy selected 

When you have selected on or more objects you can use this command to copy the 
objects to the clipboard. The objects are stored as text in XML format. You can use any 
other application to paste the objects. 

Edit - Cut selected 

This command is similar to Edit-Copy selected but the objects will also be deleted from 
the model. 

Edit - Paste 

Edit - Paste is used to insert previous copied objects from the clipboard. Relation are 
only inserted if both tables have been copied because when the objects are inserted, 
new object-identifiers are assigned. 

Edit - Delete selected 

Edit - Delete selected removes all selected objects from the model. When this happens 
unintended you can use the undo command. 

Edit - Select All 

Use Edit - Select All to select all objects from the model. 



Display Menu 

The Display Menu 

Display - Design Mode 

Select this menu item to change to Design Mode. A checkmark will be drawn left to the 
menu item when Design Mode is selected. 

Display - Query Mode 

Select this menu item to change to Query Mode. A checkmark will be drawn left to the 
menu item when Query Mode is selected. 

Display - Notation 

Display - Notation specifies the notation used to display the model. When a notation is 
selected a checkmark will be drawn left to the menu item. 

Display - Notation - EER 

Display - Notation - EER will set the notation to the common EER notation. 

Display - Notation - EER [1,n] 

Display - Notation - EER [1,n] will set the notation to another EER notation, displaying 
intervals. 

Display - Notation - Traditional 

Display - Notation - Traditional will change to a notation which will be familia to Erwin© 
users. 



Display - Table Columns-Entity Level 

Display - Table Columns will specify how tables are displayed on the model. Use Display 
- Table Columns-Entity Level to hide all column information. 

Display - Table Columns-Primary Key Level 

When Display - Table Columns-Primary Key Level is selected, only primary key columns 
are displayed. 

Display - Table Columns-Attribute Level 

Use Display - Table Columns-Attribute Level to display all columns of the tables. 

Display - Table Columns-Physical Schema Level 

Select Display - Table Columns-Physical Schema Level to display the datatypes of the 
columns. 

Display - Table Columns-Show Foreign Keys 

If Display-Table Columns-Show Foreign Keys is select foreign keys are shown as 
columns in the appropriate tables. 

Display - Table Indices 

This menu item is used to display each table's indices on the model. 

Display - List Table Indices 

A checkmark will be drawn left to the menu item when table indices are displayed. 

Display - Display Relation Names 

Display - Display Relation Names can be selected to display the names of relations. 

Display - Display Page Grid 

Select Display - Display Page Grid to show the partitioning of printable pages. You can 
use the Page & Printer Setup Dialog to change the initial page size. 

Database Menu 



The Database Menu 

Database - Database Synchronisation 

Use this function to synchronise your model with a database. This function can also be 
used with a clear database to create all the tables. 

Database - Reverse Engineering 

Use this function to create a model based on an existing database. 

Plugins Menu 

The Plugins Menu 

The Plugins Menu lists a number of DBDesigner 4 plugins available in the program's 
directory. 

Options Menu 



The Options Menu 

Options - Model Options 

Options - Model Options will call the Model Options Dialog where several options can be 
set for the model like the default datatype or the display font. 

Options - DBDesigner Options 

Options - Model Options will call the Model DBDesigner Options Dialog where several 
general options can be set. 

Windows Menu 

The Windows Menu 

Windows - Cascade 

Use this command if you have opened several models and want to arrange the windows 
in a overlapping style. 

Windows - Tile 

Use this command if you have opened several models and want to arrange the windows 
beside each other. 



Windows - Style - Standard 

The Windows-Style menu items can be used to change the overall appearance of the 
program. 

Select Windows - Style - Standard to set the style to Windows default. 

Windows - Style - Motif 

Select Windows - Style - Motif to set the style to the Motif style. 

Windows - Style - SGI 

Select Windows - Style - Motif to set the style to the SGI style. 

Windows - Style - Platinum 

Select Windows - Style - Platinum to set the style to the Platinum style. This is the 
default window style. 

Windows - Toolbar 

Checked this menu item to display the Toolbar which is docked to the left of the main 
window.

Windows - Tools (MS Windows only) 

If this menu item is checked the Tool-Palette becomes visible. It can be used instead of 
the Toolbar.

Windows - Navigator & Info Palette 

If this menu item is checked the Navigator & Info-Palette becomes visible. If it is 
unchecked the Navigator & Info-Palette is hidden. 

Windows - Datatypes Palette 

If this menu item is checked the Datatypes-Palette becomes visible. If it is unchecked 
the Datatypes - Palette is hidden. 

Windows - DB-Model Palette 

If this menu item is checked the DB-Model-Palette becomes visible. If it is unchecked 
the DB-Model-Palette is hidden. 

Windows - Reset Palette Positions 

Call this command to reset the palette positions to their initial locations. 

Windows - Dock Palettes 

Use this menu item to dock or undock the palettes to the right of the main window. 



Below this menu item a list of all opened models is displayed. Select a menu item to 
bring the appropriate menu to the front. 

Help Menu 

The Help Menu 

Help - About 

Displays the splash screen. 

Help - Online Documentation 

Lauches an explorer with this documents. 

Help - Visit fabFORCE.net 

Lauches an explorer and navigates to http://www.fabFORCE.net. 

Help - Check for New Versions 

Lauches an explorer, navigates to http://www.fabFORCE.net/downloads. 

Palettes 

Palettes are floating windows which always stay on top and provide fast access to 
important functions. 

The Toolbar / Tools Palette 

The Toolbar (and the Tools Palette) provides quick access to the most important work 
tools. (On a Linux system the Tools Palette is disable because of a limitation in the 



window system.) 

The Toolbar 

To view the Tools Palette select select [Windows]->[Tools] from the main menu. 
Deselect [Windows]->[Tools docked] to hide the docked palette. By default the Tools 
Palette can be found on the upper left corner of the screen.



The Tools Palette 

Click on the icon to activate the appropriate tool. The mouse cursor will change. Take a 
look at the Modelling Section to see how to use the single tools. 

Clicking on the buttons will call the assigned functions. Use the mode button to switch 
between the Design- and Query-Mode. In Design-Mode tables can be moved with the 
selection tool, too. In Query-Mode you have to use the Move-Tool. 

The Navigator Palette 

The Navigator Palette (top right) shows the current visible region of the model and can 
be used to navigate on the model. 



The Navigator Palette 

Navigator Page 

The current visible region is marked by a blue rectangle. When the model is scrolled or 
moved with the panning tool the marker is moved to the new position automatically. 
Click on the white area to move the marker and scroll the model to the appropriate 
position. Depending on the speed of your machine and the size of the model you can 
also drag the marker. 

To change to Zoom-Factor you can use the trackbar or click on the small and large 
table symbol left and right to the trackbar. To enter the zoom factor manually click on 
the zoom edit, type in the desired value (without percent charater) and press enter. 

Click on the upper right icon to display the palette's popup menu. Select a menu item 
to set the zoom factor to the displayed value. 

Info Page 

Click on the Info-Tab to switch to the info page. On this page you can change the name 
and position of the selected object. When two or more objects are selected it is not 
possible to a value. When an image is selected the size can also be changed. 

The Datatypes Palette 

The Datatypes-Palette (middle right) shows the existing datatypes which can be used to 
build the database-tables. 



The Datatypes Palette 

Common Datatypes Page 

On the Common-Tab the most used Datatypes are visible and are ready to be dragged 
onto table columns. To add a new User Defined Datatype click the upper right icon to 
display the palette's popup menu. Select Create New Datatype and the Datatype-Dialog 
will be displayed showing the new created datatype. To remove a Datatype from the 
Common-Tab select Del from Common Datatypes from the palette's popup menu. 

All Datatypes-Page 

Click on the All types-Tab to display all available datatypes. The datatypes are split into 
five categries. Numeric Types, Date and Time Types, String Types, Blob and Text Types 
and User defined Types. Doubleclick on a category to show all assigned datatypes. New 
created datatypes will always be assigned to the User defined Types. Doubleclick on a 
datatype to call the Datatype Editor. Select and right click on a datatype and select Add 
to Common Datatypes to add a Datatype to the Common-Tab. 

Replace Datatypes in Tables 

If you want to replace a datatype or change a parameter in several tables then you can 
use the Replace Datatypes in Tables function from the palette's popup menu. It works 
just like the Search and Replace function in Word©. 



The Replace Datatype Dialog 

Select the datatype you want to replace. Then select the datatype which should be 
inserted. To change only the parametes of a datatype select the same datatype in both 
dropdowns and check the Mach Params flag and enter the parameter you want to 
replace and the parameter which should be inserted. 

Select the Region of the function and press Execute to replace the datatype. 

Reinitialise Datatypes 

To reset the datatypes to their initial state select Reinitialise Datatypes from the 
palette's popup menu. The inital settings will be loaded from the ini-files. Manually 
created datatypes will be replaced by the standard datatype of the model. 

The DB-Model-Palette 

The DB-Model-Palette displays all existing tables in the model and their columns and 
relations. 



The Model Palette 

Click on the plus symbols to display the columns and relations of a table. Doubleclick on 
a table to call the Table Editor or select Edit Object from the table's popup menu. 

The Staturbar 

The Statusbar displays information about the currently selected Tool an can be used to 
read and set the zoom factor to a predefined value, fast. 



The Statusbar 

Click on the Zoom Factor Edit left on the Statusbar. A list of zoom factors pops up. 
Select the desired zoom factor or press ESC to close the list. 

If the database model is modified the indicator left to the Zoom Factor Edit is painted 
red. Click on the Disc Icon to save to model to disk. Click on the Database Icon to save 
the model in a Database. 
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Editors 
Editors are used to specify and modify parameters of objects, datatypes, ... 

An object's editor is usually called by doubleclicking on the object. 

Table Editor 

Call the Table Editor by doubleclicking on a table or selecting [Edit Object] from the table's popup 
menu. You can also doubleclick the tables name in the DB-Model Palette or use the right mousebutton 
to call the popup menu there. 

How to use the Table Editor 

To use the Table Editor the most efficient way use the following procedure. 

I.) Create a new table in the model. Doubleclick on the table to call the Table Editor. The Table Name is 
focused so enter the table name. Press [Return]. 

II.) The focus will be set to the first line of the Table Columns. The first column will be named 
id+tablename automatically. If the first column has to have a different name enter the column's name. 
Then press [Return]. 

III.) Enter the next column name and press [Return]. Repeat this for all columns. Ignore the datatypes 
of the columns at this time, all columns' datatypes are set to the default datatype initially. 

IV.) After the last column has been entered, press [Esc] to abort the column edit mode. 

V.) To assign the datatypes to the columns start by dragging the first column's datatype from the 
Datatype palette onto the first column. Enter the datatype's parameters if the Parameter Editor pops 
up, e.g. VARCHAR(___)
Repeat this for all column types. 

VI.) To define the primary key click on the columns' icon (left to the column name) to add or remove 
the column from the primary key. 

VII.) Optionally define additional indices, the table options, the standard inserts and the table 
comments. 



The Table Editor 

Table Settings 

Table Name 

Table Name displays the current name of the table. By pressing Return or leafing the edit field the 
Table Name is checked against the reserved word list. If the Table Name equals a reserved word it is 
changed automatically. 

Table Prefix 

In MySQL the Table Prefix can specify the database (db_name.tbl_name). Use this function if you want 
to administrate several databases in only one model. The Table Prefixes are defined in the Model 
Options. 

Table Type 

MySQL supports several different Table Types. The most common types are MyISAM which is the 
default type and InnoDB which supports transaction-safe tables with row locking. 

Weak entity 



Check the [is n:m Table] checkbox if this table is a n:m Table. 

Table Columns 

The cursor keys can be used to move the Cursor between the Column Name, Datatype and the Default 
value and the table columns. Press enter to change the focused value. 

Use the mouse to dray an new datatype from the Datatype Palette onto the column. Doubleclick the 
datatype to change the datatype's parameters. 

Click on the Table Column's row to change the NOT NULL Flag, the Column Options and the 
Autoincrement Flag. 

The Table Columns 

To enter a new column click on any column name an press the Page Down Key. The Cursor is placed 
below the last column. Add the new column by entering the column name. 

If you want to enter several new columns press return. The Curor is moved to the next row and the 
next column name can be entered. 

Drag the appropriate datatype from the Datatype Palette onto the new column. Enter the datatype's 
parameters if needed. 

Set the Column's NOT NULL Flag, the Column Options and the Autoincrement Flag if nessesary. 

Table Indices 

An unlimited number of indices can be defined for each table. The PRIMARY index is defined 
automatically and cannot be deleted. 

The Indices List 



To add a new index click the plus button and enter the index name. Select the Index Type. You cannot 
select the primary type manually because there can only be one primary index. 

To delete an index select it in the index list and click the rubber button. 

An Index 

To add columns to the index drag the appropriate Table Columns down to the Index Columns listbox. 
You can reorder the index's columns by drag'n'drop in the Index Columns listbox. 

To delete a column from the index select the column in the Index Columns listbox and click the rubber 
button to the right. 

Standard Inserts 

Every table can have it's Standard Inserts. They provide initial data for the tables. 

When the SQL Creates are exported or the database is created by the syncronise function the Standard 
Inserts can be exported or executed as well. 

The Standard Inserts 

To add a SQL INSERT command click the right mouse button and select Paste SQL Insert from the 
Standard Inserts memo's popup menu. 

To clear the Standard Inserts click on the rubber button right to the Standard Inserts memo. 

Table Options 

The Table Options provide access to the MySQL specific table options. Please refere to the MySQL 
documentation to understand the functionality of the several Table Options. 



The Table Options 

Advanced Table Options 

Like the Table Options the Advanced Table Options provide access to the MySQL specific table options. 
Please refere to the MySQL documentation to understand the functionality of the several Table Options. 

The Advanced Table Options 

Comments 

To store additional information about the table select the Comments and enter the information. 

Table Comments 

Relation Editor 

The Relation Editor allows you to change the Kind of the relation, the Foreign Keys fields mapping and 
the Relation Reference Definition. 



The Relation Editor 

Relation Name 

Change this value to rename the relation. 

Relation Kind 

A relation can be one of the following kinds. 

Kind Caption Explanation Example

1:1 one - to - one relation One row in the source table 
matches one row in the 
destination table.

A relation between a [customer] 
table and an [address] table. One 
customer has one address.

1:n one - to - many relation One row in the source table 
matches many rows in the 
destination table.

A relation between an [order] table 
and a [orderproduct] table. One 
order can have many products and 
a product in the [orderproduct] 
table is only part of one order.

1:n (Non Identifying) one - to - many relation, FK not in PK One row in the source table 
matches many rows in the 
destination table but the Foreign 
Key in the destination table is 
not in the Primary Key Index.

A relation between a [payment] 
table and an [order] table. Each row 
in the [order] table as a [payment] 
assigned to. Only [idorder] is the 
Primary Key field in the [order] 
table.

n:m many - to - many relation A n:m relation is always broken 
down into two 1:n relations.  

1:1 (Generalisation) one - to - one relation This relation is treated like a 
normal 1:1 relation within 
DBDesigner 4. Some plugins 
make use of this type of 
relation.

 

Invisible 



Use this option to hide the relation. To make the relation visible again select the source table or the 
destination table in the Model Palette, expand the relations and doubleclick the invisible relation. In the 
Relation Editor disable this option. 

Foreign Keys 

Use the Foreign Key table to change the fieldnames of Foreign Keys in the destination table and to add 
additional comments to the fields.

Doubleclick a value to change it. 

Reference Definitions 

Select the Create Reference Definition checkbox to activate the Reference Definitions. Use the 
comboboxes to select the appropriate actions for delete and update events.

Please note that native MySQL tables do not support Foreign Key Reference Definitions. Use InnoDB if 
Foreign Key Reference Definitions are needed. 

Optional Relation 

To make the relation optional on one side check the appropriate option. 

Comments 

Use the Comments Memo to enter additional information about the relation. 

Region Editor 

Call the Region Editor from the region's popup menu. The Region Editor allows you to define default 
table settings for all tables positioned on the region.

To activate set default settings selected the wanted options and enable the checkbox next to that 
option. 



The Region Editor 

Regionname 

Change this value to rename the region. 

Color 

Each region is painted in an individual color. Choose from the list to specify the region's color. 

Overwrite Table Settings 

Select the appropriate settings and check the overwrite checkbox to activate them. 

Comments 

The comments memo can be used to store informations about the region. 

Note Editor 

Doubleclick on a new created note to enter call the Note Editor and enter the note's text. 



The Note Editor 

Image Editor 

Doubleclick on a image to call the Image Editor. 

The Image Editor 

Load New Image 

To replace this image with an updated version of the image or a different image click the Image Folder 
button. A file browser is shown and you can select the image. 

Currently only the PNG and BMP image formats are supported. 

Strech Image 

When the Strech Image option is selected you are able to resize the image. 

Restore Size 

To restore the original size of the image after it has be rescaled press the Restore Size button. 

Restore Aspect Ratio 

When the image has been resized and the aspect ratio was changed press the Restore Aspect Ration 
button to change the height of the image according to the aspect ration. 

Clear Image 

Press the Clear Image button to remove the bitmap. 



Datatype Editor 

Doubleclick on a datatype in the Datatype Palette to call the Datatype Editor. 

Query Editor 

To call the Query Editor from Design Mode right-click on the table and select Edit Table Data from the 
popup menu. 

When DBDesigner 4 is Query Mode a docked Query Editor is shown at the bottom of the main window. 
To open another editor double-click on the appropriate table. 

If there is no active database connection the Database Connection Dialog will be shown. Create a new 
or select an existing database connection and click connect. 

The Query Editor 

Main areas 

The Query Editor can be divided into two main areas, the SQL Command Editor and the Data Grid. 

The SQL Command Editor is used to specify a SQL Command. The Data Grid will display the result 
returned from the Database. 

The SQL Command Editor is extended by the SQL Command Storage Tree. The SQL Command Storage 
Tree is used to store SQL commands permanently with the model and to keep a command history. 

The Data Grid is extended by the BLOB Editor. BLOB Editor is used to modify, load and save data from 
or to BLOB fields. 

Viewing and hiding the areas. 

When the Query Editor is opened from Design Mode or by double-clicking a table in Query Mode, only 
the Data Grid is visible. To display the SQL Command Editor click the SQL button at the right. 

To display the SQL Command Storage Tree click on the tree icon right to the SQL Command Editor. 

To edit the content of a BLOB Field click on the BLOB button at the right. 
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Database Creation and Maintenance 

Traditional SQL Export 

Like any other database modelling tool DBDesigner 4 can export the model as a SQL script file which can be executed by 
any database maintenance tool, like the MySql command line tool.

All SQL CREATE TABLE statements and the Standard Inserts can be written to the SQL script file depending on user 
settings.

It is also possible to output all SQL DROP TABLE statements. 

What is Database Synchronisation? 

With DBDesigner 4 you can simplify the task of creating and maintaining your database. DBDesigner 4 offers the ability to 
connect to a MySQL server and to create and synchronize a database with the designed model.

Synchronisation means that DBDesigner 4 scans all tables in the existing database and checkes for differences. If a table is 
present in the model but not in the database, the according SQL CREATE TABLE statement is executed.
If the table is not present in the model but in the database it can be deleted depending on user settings.
If the table exists in the model and the database as well, all fields are compared and if there is a difference, the appropriate 
SQL ALTER TABLE statements are executed. 

What is Reverse Engineering? 

To reverse engineer a database means to connect to a database server, take an existing database and automatically build a 
database model based on the meta information in the database.

Within DBDesigner 4 all table information is extracted from the meta information and relation between the tables are 
rendered based on table and field names. The tables are placed on the model in alphabetical order following a grid scheme 
defined by the user. 
The process of reverse engineering is possible with MySQL, Oracle and any database which is accessable by ODBC.

The extraction of all table information is only possible using a MySQL database. All other databases are limited to the 
bottleneck of ODBC. 

Export SQL Creates 

To export a SQL create script based on you current database model select File-Export-SQL Create Script ... The Export SQL 
script dialog appears. 



Export SQL Creates dialog 

To export the SQL Creates to a file, press the [Save script to file] button. You will be promted for the file's name and 
destination. Press [Save] to write the script to disk.

When a sql shell is open, it can be useful to copy the script to the clipboard and execute it directly from the sql shell. To 
copy the SQL script to the clipboard press the [Copy Script to Clipboard] button. 

SQL Create Options 

The output can be customised using the following General Settings and the SQL Creates Settings. 

Export selected tables only 

Check this flag to export the selected tables only. All other tables will not be created by the script file. 

Order Tables by Foreign Keys 

Use this flag to change the creation order. By default the tables are created in alphabetical order. When you are using 
foreign keys it is necessary to change the order the tables are created.

Tables with no relations pointing to them have to be created first. Every other table can only be created when all source 
tables already exist.
If there is a collection of cyclic relations, the tables cannot be created. An error message is displayed. Note that you still can 
export the tables in alphabetical order. 

Define Primary Keys 

Check this flag if you want to enable the creation of primary keys. 

Create Indices 

Check this flag if you want to enable the creation of indices. This does not include the primary keys. Check the Define 
Primary Keys flag to create primary keys. 

Define Foreign Key Reference 

Use this option to enable the foreign key reference in the SQL CREATE TABLE statements. Note that you have to enable the 
Order Tables by Foreign Keys option to make the SQL script work. 

Output Table Options 

Use this option to enable the table options in the SQL CREATE TABLE statements. This is only necessary if you have 
specified Table Options for a table in the model. 

Output Standard Inserts 

Use this option to export the Standard Inserts within the SQL create script. This is only necessary if you have specified 
Standard Inserts for a table in the model. 



Export SQL Drops 

To export a SQL drop script based on you current database model select File-Export-SQL Drop Script ... The Export SQL 
script dialog appears. 

Export SQL Drops dialog 

To export the SQL Drops to a file, press the [Save script to file] button. You will be promted for the file's name and 
destination. Press [Save] to write the script to disk.

When a sql shell is open, it can be useful to copy the script to the clipboard and execute it directly from the sql shell. To 
copy the SQL script to the clipboard press the [Copy Script to Clipboard] button. 

SQL Drop Options 

The output can be customised using the following General Settings and the SQL Creates Settings. 

Export selected tables only 

Check this flag to export the selected tables only. All other tables will not be dropped by the script file. 

Order Tables by Foreign Keys 

Use this flag to change the creation order. By default the tables are dropped in alphabetical order. When you are using 
foreign keys it is necessary to change the order the tables are dropped.

The tables will be dropped the reversed order they have been created.
If there is a collection of cyclic relations, the tables cannot be created. An error message is displayed. Note that you still can 
export the tables in alphabetical order. 

Database Connections 

Several functions in DBDesigner 4 use Database Connections. They are used to establish a connection to a database by 
selecting the appropriate server and database. 

Create a new Database Connection 

A new Database Connection is created in the Database Connection Dialog. 

To create a new Database Connection, click the New Database Connection button. The Connection Parameter Dialog is 
shown. Specify all needed information an click OK to add the connection to the connection list. 

Connect to a database 

Like creating a new Database Connection, the Database Connection Dialog is used to connect to a database. 

Select the appropriate connection from the connection list. Enter a username and the password and press the Connect 
button to establish the connection. 



Please notice 

To make changes to meta information in a database it is necessary to connect as an user with the required rights. Within 
MySQL the database administrator is called root. He has got all rights and is allowed to create a new database or make 
changes to any database. Every other user is allowed to access and modify only the tables he has got the appropriate rights 
for.

To avoid problems while synchronizing or quering a database make sure the user which is used to build the connection to 
the database has the required rights. 

The Database Connection Dialog 

Database Connection Dialog 

The Database Connection Dialog is seperated into three areas, the Network Hosts Tree, the Connection List and the 
User/Password Section. 

Network Hosts Tree 

The Network Hosts Tree displays all entered hosts and their databases. It is used to filter the displayed connections and to 
create new connections to a host's databases.

When the first node named [All Connecions] is selected, all entered connections are displayed in the Connection List.

To display all connections to the local MySQL host select [MySQL]-[Local Host].

To display all connections to MySQL host located on the network select [MySQL]-[Network Hosts].

To display all connections to a specific MySQL network host select the hosts name beneath the [MySQL]-[Network Hosts] 
node.

Connections to Oracle or ODBC databases can be filtered like the MySQL connections. 

Display a Host's databases 

To display the databases of a entered Host click on the [+] icon left to the Host's name. DBDesigner 4 prompts for the 
user's name and password which will be used to log in. Note that the specified user has to have the appropriated rights to 
execute a SQL SHOW DATABASES command. 

Enter a new Host 

After the installation of DBDesigner 4 it is possible only to connect to the local MySQL host. To add a new network host 
obey the following.

To enter a new Host, click onto the [...] node listed beneath the [Network Hosts] node beneath of the wanted database 
type. The Add new Host Dialog will apear. 



Add new Host Dialog 

Enter the node's name followed by a slash and it's IP address. In place of the IP address the host's network name can be 
specified also, e.g. webserver or www.theserver.com.

Press return to create the append the new Host to the Network Hosts Tree. 

Change Host parameters 

To change a Hosts name or IP address right click on a Host. The Host's popup menu will be displayed.

Host popup menu 

Select the desired function from the menu.

Remove a Host 

To delete a Host select [Delete Host] from the popup menu. 

Create a new database 

It is possible to create a new database from within the Database Connection Dialog. To create a new database display the 
Host's databases like descibed above. Click the last node below the Host's node which is labeled [...]. The New Database 
Dialog will apear. Enter the database name and press return. The database will be created. 

Drop a database 

It is possible to drop a database from within the Database Connection Dialog. To drop a database show the Host's 
databases like descibed above. Click the database's node with the right mouse button to display the popup menu. Select 
[Drop Database].

Be aware that once a database is dropped it cannot be restored. A database backup has to be restored instead. 

Connection List 

The Connection List displays the connections selected in the Network Hosts Tree. Click on the wanted connection to set the 
connection in the User Section.



Creating a new connection 

To create a new connection select the Host to connect to in the Network Hosts Tree. Display the Host's databases. Now 
drag the database to connect to onto the Connection List. A new connection is created.

Instead of dragging the database you can select the database with the left mouse button and press the [New Connecion to 
selected Database] button. 

The list's columns 

The list has got six columns. The connecion name displays the name of the connection. Double click on the name to change 
it.

The type displays the type of database the connection is refering to. Doubleclick the type to change it.

Click on the [...] button to display the connection parameters. 

The User Section 

When a database connection is selected in the Connection List the connection's name is displayed in the User Section and 
DBDesigner 4 prompts for the user's password. The password is never stored with the database connection because of 
security issues.

Press enter or click the [Connect] button to establish the database connection. If the connection was successfully build the 
connection dialog is closed. If an error occured, e.g. the password was wrong, a the error message is displayed. 

Connection Parameter Dialog 

The Connection Parameter Dialog is used to change.

Connection Parameter Dialog 

Connection Name 

Each Database Connection is identified by a unique name. 



Host Caption 

Enter a caption for the database server. Only needed for MySQL connections. 

Host IP 

Enter the database server's IP address or network name. Only needed for MySQL connections. 

Database name 

Enter the name of the database. When using the MySQL Driver this is the name which was used in the CREATE DATABASE 
SQL statement. 

When the ODBC Driver is selected enter the ODBC Data Source Name (DNS). 

When using the Oracle Driver enter the connection name. 

Driver 

Select a database driver from the dropdown list. When a new database driver is selected all values are set to their initial 
state. 

Username 

Specify the username used to connect to the database. 

Password 

Specify the password used to connect to the database. 

Description 

Enter a description with a short information about the database connection. 

Advanced Tab 

Beware. Only modify the advanced connection parameters if you know what you are doing. The [Reset to Defaults] can be 
used to reset the connection parameters to their defaults. To add or delete a parameter use the according buttons. 

The default parameters can be modified by editing the file DBDesigner4_DBDefaultSettings.ini located in the DBDesigner 4 
data directory. 

The host column displayes the entered IP or network name of the host. Double click on the host's IP/network name to 
change it. 

The database column displays the database the connection is build to. It can be changed using a double click. 

The description column displays additional information about the connection. It can be changed using a double click. 

Database Synchronisation 

To synchronise the model with a database select [Database]->[Database Syncronsiation] from the main menu. The 
synchronisation can also be called by pressing the [Sync] button in the Tools palette. Note that an empty model cannot be 
synchronised.

The Database Connection Dialog will be shown. Select the connection to the database which should be synchronised. Enter 
the user's password and press [Connect] to establish the connection. 

Synchronise with a new database 

The synchronise function can be run against an empty database. All tables will be created and the Standard Inserts will be 
inserted into the tables.

To synchronise the model with a new database call the Database Synchronisation. The Database Connection Dialog is 
displayed. To create a new database display the Host's databases and click the node labeled [...] like explained above. 
Name the database an create a new connection by dragging the database's node onto the Connection List. Connect to the 
new database. 



Database Synchronisation 

Synchronisation options 

When the connection to the database is established successfully the Database Synchronisation Dialog is displayed.

Database Connection 

The name of the database connection is displayed at the top. To connect to a different database click the button right to the 
connection's name. The Database Connection Dialog is displayed again and a different connection can be selected. 

Apply changes to Database 

This option is seleted by default. The database will be modified to reflect the changes made to the model. The model will be 
unchanged when the synchronising function is executed. 

Apply changes to Model 

To modify the model instead of the database select this option. The database will be unchanged when the synchronising 
function is executed.

This function will be enabled in upcoming versions of DBDesigner 4. At the moment use the Reverse Engineering functions 
instead. 

Don't delete exisiting Tables 

Check this option to keep tables in the database which are not present in the model. If this option is not checked these 
tables will be dropped. 

Execute Standard Inserts when Creating New Tables 

If this option is activated the Standard Inserts will be inserted into the new created table. This option is selected by default. 

Synchronise Standard Inserts 

Activate this option when changes to the Standard Inserts of a table have been made. The rows will be compared using the 



primary key fields. If a row in the database matches with a row in the Standard Inserts all the values entered in the 
Standard Inserts will be compared. Values not present in the Standard Inserts will be ignored. Appropriate changes are 
made to the database table rows.

Database table rows with a primary key value which is not matched by and primary key value in the Standard Inserts are 
kept unchanged. Because of that manually entered rows will stay in the table even when this option is used. If a Standard 
Insert is deleted in the model the it has to be removed from the according row in the database table has to be deleted 
manually. 

Executing the synchronisation 

The synchronisation cannot be undone. Before executing check all selected options. Check the Progress List which will 
display the connection info and the number of tables in the database and the model. The connection info will be printed like 
this [user@database], e.g. [root@webshop].

To execute the synchronisation press the [Execute] button at the bottom of the dialog.

The execution can be monitored through the Progress List. All checks and changes are listed. 

Reverse Engineering 

To call the Reverse Engineering function select [Database]->[Reverse Engineering] from the main menu. The function can 
also be called by clicking the [Rev.] button in the Tools Palette.

Normally the Reverse Engineering function is called with an empty model. It is also possible to add the tables to an existing 
model. If the database tables should be created within a new model select [File]->[New] from the main menu before calling 
the function.

The Database Connection Dialog will be show. Select or create a new connection to the database which should be reverse 
engineered and establish the connection. 



Reverse Engineering Dialog 

When the connection to the database is established successfully the Reverse Engineering Dialog is displayed.

Database Connection 

The name of the database connection is displayed at the top. To connect to a different database click the button right to the 
connection's name. The Database Connection Dialog is displayed again and a different connection can be selected. 

Tables 

Select all database tables which should be created in the model. All tables are selected by default. To select all tables when 
some of them have been deselected press the [Select all Tables] button. To deselect all tables press the [Deselect all 
Tables] button. 

When an MS Access Database is selected the MS Access' system tables are deselected automatically. 

General Options 

Use MySQL specific functions 

Check this option when a MySQL database is reverse engineered. MySQL specific functions like DESCRIBE TABLE will be 
used to generate the most accurate copy of the table's structure. Do not use this option with any other database. 

Use general functions 

Use this option when any other than a MySQL database is reverse engineered. 

Number of tabels in a row 

When the database is reverse engineered all the selected database tabels are placed in a grid on the models canvas. This 
option specifies the number of tables in a row. 

Build Relations 

Use these options to let DBDesigner 4 create the relations between the tables automatically. Please note that this may lead 
to incorrect results. So always check the relations after the database has been reverse engineered. 

Build Relations based on Primary Keys 

Check this option to build relations between the tables in the model automatically. The relation will be build upon the table 
primary key fields. When the PK fields of a table are present in another table a 1:n relation is created. 

Build Relations based on Tablenames 

Check this option to build relations between the tables in the model automatically. The relation will be build upon the table's 
and primary key field's names. The following naming principle is assumed. The primary key of a table is named ID + 
Tablename. If the primary key name is present in a different table a one-to-many between the two tables is created. 

Use Datatype substitution 

Check this option if you want to change some datatypes' names. This option can be used to map different datatypes 
between different databases.

By default the Datatype Substitution [MySQL Standard] is selected. This substitution will replace MySQL's abbreviations 
[int] and [dec] with the [INTEGER] and [DECIMAL] datatypes. 

To change a datatype's name enable this option, change the Datatype Substitution to [User defined] and add a line to the 
Datatype Substitution List. Use the following format. [OldDataypeName=NewDatatypeName], e.g. [int=INTEGER] will 



replace all [int] datatypes with [INTEGER] datatypes. 

Executing the function 

To execute the function press the [Execute] button at the bottom of the dialog.

Create Standard Inserts from table data 

This option can be used to automatically create Standard Inserts for the created tables. The Standard Inserts will be built 
from the table's data stored in the database. 

Limit number of records to... 

The number of created Standard Inserts can be limited to a maximum number by using this option. This can be useful if 
there are many rows stored in the table but only a few records are needed for testing purposes.
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Keyboard Shortcuts 

Navigation 

Key Function Info

F1 Help Calls the context sensitive Help.

Space Panning Holding down the Space-Key activates the 
panning function till the key is released.

Ctrl + Space Zoom in Holding down the Space-Key and the Ctrl-Key 
activates zoom-in function till the key is 
released.

Alt + Space Zoom out Holding down the Space-Key and the Alt-Key 
activates zoom-out function till the key is 
released. You can press Space + Ctrl + Alt, 
too.

Ctrl + Tab Switch 
Workmode

Changes the Workmode from Design to Query 
and vice versa.

Ctrl + Shift + Tab Switch Palettes Press once to hide all palettes and again to 
show the palettes again.

Ctrl + Shift + 1..0 Store Position 
Markers

Press Ctrl + Shift + 1,2, .. 0 to store a 
Position Marker.

Ctrl + 1..0 Recall Position 
Markers

To recall a Position Marker press Ctrl + 1,2, .. 
0. The position and zoom factor of the stored 
marker will be restored.

Design Mode 

Key Function Info

Ctrl + Q Select Object(s) Activates the Pointer cursor. In Design-Mode 
objects can also be moved with this cursor.

Ctrl + W Move Object(s) Activates the Move cursor. Needed to move 
objects in Query-Mode.



Ctrl + E Scale Object Activates the Scale cursor. Only used for 
Regions and Image objects.

Ctrl + T New Table Switches the mouse cursor to New Table 
Mode.

Ctrl + Shift + R New 1:n 
Relation

Switches the mouse cursor to New 1:n 
Relation Mode.

Ctrl + R New 1:n 
Relation (non 
identifying)

Switches the mouse cursor to New 1:n non-
identifying Relation Mode.

Ctrl + Shift + Alt R New 1:1 
Relation

Switches the mouse cursor to New 1:1 
Relation Mode.

Ctrl + A Select All Selects all objects

Ctrl + Del Delete Selected Deletes all selected objects.

Ctrl + Shift + C Copy 
Highlighted 
Name

Copies the Highlighted Name to the Clipboard.

Ctrl + Z Undo last Action Undos the last Action

Ctrl + Shift + Z Redo last Undo 
Action Redoes the last Undo Action

Ctrl + O Open model Opens an existing model.

Ctrl + S Save model Saves the current model. The model can also 
be saved by clicking on the disk icon in the 
status bar.

Query Mode 

Key Function Info

F9 Execute SQL 
statement Executes the current SQL statement.

Ctrl + Q Select Object(s) Activates the Pointer cursor. In Design-Mode 
objects can also be moved with this cursor.

Ctrl + S Add Column to 
SELECT

Mouse Cursor to add Columns to the SELECT 
part of a SQL Command.

Ctrl + F Add Column to 
FROM

Mouse Cursor to add Columns to the FROM 
part of a SQL Command.

Ctrl + W Add Column to 
WHERE

Mouse Cursor to add Columns to the WHERE 
part of a SQL Command.



Ctrl + G Add Column to 
GROUP BY

Mouse Cursor to add Columns to the GROUP 
BY part of a SQL Command.

Ctrl + H Add Column to 
HAVING

Mouse Cursor to add Columns to the HAVING 
part of a SQL Command.

Ctrl + O Add Column to 
ORDER BY

Mouse Cursor to add Columns to the ORDER 
BY part of a SQL Command.

Ctrl + E Add Column to 
SET

Mouse Cursor to add Columns to the SET part 
of a SQL Command.

Ctrl + Shift + A Copy SQL to 
Clipboard

Copies the current SQL Command to the 
Clipboard, formated for ASP.

Ctrl + Shift + D Copy SQL to 
Clipboard

Copies the current SQL Command to the 
Clipboard, formated for Delphi/Kylix.

Ctrl + Shift + P Copy SQL to 
Clipboard

Copies the current SQL Command to the 
Clipboard, formated for PHP.
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DBDesigner 4 - Version History 

Source Releases 

Version Changes

4.0.2.88 • Bugfix: Plugin - Data was not loaded. Fixed.
• New: Whan using the Database Synchronisation function 
tables are now renamed if the name was changed in the model. 
Previously they had beed dropped and recreated.
• New: Index Columns now support the additional lenght 
parameter for BLOB fields.

4.0.2.87 • Bugfix: Version number was not automatically increased when 
model was stored in database and option was selected. Fixed.
• New: The model's version can now be edited in model option 
dialog.

4.0.2.86 • First puplic release. Version history will start from this version.

Documentation Releases 

Version Changes

1.0.42 •Renamed syncrosation to synchrosation.
• Added Plugins Menu

1.0.41 • New Modelling and Quering Section.

1.0.40 • Updated Screenshots and listing of new functions.

1.0.39 • Improved Fundamentals section. Included GNU GPL with the 
Online and PDF documentation.

1.0.38 • First puplic release. Version history will start from this version.
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